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MLA Style: A Summary for Sunset Students 

This summary provides helpful information for students in their writing assignments at 

Sunset.  It is based on the MLA Handbook (8th edition, 2016), a required textbook for Level 1 

students in the “Introduction to Ministry Study” course.  The summary gives emphasis to 

formatting assignments and documenting sources in research papers.  Additional information is 

available online from the MLA website: https://style.mla.org. 

The first two pages of this paper illustrate the basic format of a research paper and an 

evaluation paper.  Notice the absence of bold and underlined text and of a title page, as it is not 

required in the MLA format.  Notice how the page numbers follow the student’s last name in the 

header, the double spacing throughout, and the works cited examples below.  Reference pages 10 

through 15 for examples of “Frequently Cited Books and Periodical Articles in Print” and see 

how they are in alphabetical order.  If indenting problems in the works cited exists, try pressing 

enter before pressing the tab button. 

There are four sections in the summary.  Most of the information deals with writing a 

research paper.  The first section, however, deals with other types of written assignments     

(page 1).  The title of the second section is “Formatting the Paper” (pages 3-7).  The third 

section, “Documentation,” summarizes the proper ways to document sources, both in the text of 

the paper and in the list of works cited (pages 7-10).  The final section gives examples of 

commonly used types of documentation and a sample of a list of works cited (pages 10-15).  
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Section 1 – Writing Assignments: Non-Research Papers 

For book reports, there is no need for a work cited page.  The publishing information 

should, however, be included in the first or second paragraph of the report. 

For other typed assignments (e.g. themes, essays, and other assignments that do not 

require research), MLA formatting should be followed. 

For all other assignments, whether they are handwritten or typed, students should ask 

their instructors if it is necessary to follow MLA style.     

Section 2 – Formatting the Paper 

1. Margins: should be one inch at the top, bottom, and on both sides of the text. 

2. Text Formatting  

• Use a readable font (e.g. Times New Roman) in which the regular type style contrasts 

clearly with the italic type. 

• Use a standard size (e.g. 12 point).   

• Do not use Courier or other mono-spaced or fixed-pitched fonts. 

• The entire paper should have the same font, font size, and font style (except when italics 

are required for book and journal titles). 

• Do not justify the lines of text at the right margin. 

• Turn off any automatic hyphenation feature. 

• Double-space the entire paper. 

• Indent the first line of a paragraph one-half inch from the left margin. 

• Indent each line of a set-off quotation one-half inch from the left margin (see MLA 

Handbook, pages 76-80, for examples). 
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• The preferred MLA way is to use one space after a period or other concluding 

punctuation mark.  Using two spaces, however, is acceptable at Sunset.  Each student 

should choose and then be consistent throughout the paper. 

• Do not add a space before or after each paragraph. 

3. Heading and Title (For an example, see the first page of this summary.) 

• Do not use a title page.  Instead, beginning one inch from the top of the first page and 

flush with the left margin, the following information, in this order, should be given on 

four separate lines: 1) name of the student, 2) name of the instructor (preceded by the 

title, Instructor), 3) name of the course, and 4) date the paper is turned in.  Both examples 

are acceptable for the date: August 12, 2016 and 12 August 2016.  Do not use 

abbreviations; these examples are not acceptable: Aug. 12, 2016 and 08/12/16. 

• The above information should be on the first page only. 

• Center the title of the assignment on the first double-spaced line after the date.  

• Do not change the font size, italicize or underline the title; do not use quotation marks, 

boldface type, or use all upper-case letters.  Follow the rules for capitalization (MLA 

Handbook, pages 67-68) and use italics only on words that would be italicized in the text    

(e.g. A Review of Haddon W. Robinson’s Biblical Preaching).  

• The text of the paper should begin on a new, double-spaced line after the title, indented 

one-half inch from the left margin. 

4. Page Numbering  

• All pages should be numbered consecutively throughout the paper in the upper right-hand 

corner, half an inch from the top and flush with the right margin. 
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• The student’s last name should be typed first, followed by a space, and then the page 

number.  If there is more than one student with the same last name, include the first letter 

of the first name, followed by a period and a space before typing the last name. 

• After this is done on the first page, most word processors will do this automatically on 

each additional page.     

• Do not use the abbreviation p before the number or add a period, hyphen, or any other 

mark or symbol.  Do not use boldface type or use a font and size that are different from 

the font and size used in the text of the paper. 

• Beginning with page 2, position the first line of the text one inch from the top of the page. 

5. Placement of the List of Works Cited 

• This should appear at the end of the paper (after endnotes, if used). 

• The list should begin on a new page.   

• The page numbering should continue uninterrupted (e.g. if the text of the paper ends on 

page 10, the list of works cited should begin on page 11). 

6. Paper and Printing 

• Use only white, 8½-by-11-inch paper, unless another size and/or color is specified by the 

Instructor 

• Use a high-quality printer. 

• Print on only one side of each sheet of paper. 

7. Corrections and Insertions on Printouts 

• Do not wait to make corrections until the paper is printed. 

• If there are only a few errors, make corrections in ink, above the error, using a caret (an 

inverted “v” – ^) to indicate where they go.        
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• Do not write in the margins or below the line(s) affected. 

• If there are numerous corrections on any page, correct them and reprint the page.    

8. Binding 

• Secure the paper with a single staple in the upper left corner.   

• Do not use a plastic folder or other kind of binder. 

9. Submitting a Paper via e-mail 

• Usually, assignments may be submitted as an attachment to an e-mail 

• Students should check with the Instructor to be sure such submissions are acceptable. 

10. Preparing the first page of an Assignment (using a “Word” document) 

• Select the Home tab 

1) Select and choose Font 

2) Select and choose Size 

3) Under “Line and Paragraph Spacing,” check 2.0 AND click “Remove Space After 

Paragraph” 

• Select the Layout tab: Under “Margins,” click Normal (for 1” margins) 

• Select the Insert tab 

1) Select Page Number 

2) Click Top of Page and select Plain Number 3 (upper right corner) 

3) Type last name and insert 1 space before the page number 

4) Highlight the name and page number; make them the same as the previously chosen 

font and size (under the Home tab) 

5) To exit and return to the document, move the cursor into the area of the “text” (below 

the line of dashes) and double click 
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• Select the Home tab 

1) On the next 4 lines, type name, instructor’s name, and the name of the course, then 

type the date 

2) Type the name of the assignment, centered, on the next line (after the date), and hit 

the enter key 

3) Return to “Align Left,” indent ½ inch (use the tab key) and begin writing 

Section 3 – Documentation 

1. In-Text Citations 

• Sources are acknowledged in the text by keying brief in-text citations (also called 

parenthetical citations) to an alphabetical list of Works Cited (at the end of the paper). 

• The citations must point to the specific source in the list of Works Cited and be identified 

as specifically as possible. 

• Citations contain only enough information (e.g. Long 68) to enable readers to find the 

source in the list of Works Cited.  If the author’s name is cited in the text, only the page 

number appears (e.g. 68).  If more than one work by the author is in the list of Works 

Cited, a shortened version of the title should be given (e.g. Long, Witness 68).  Additional 

examples are given on page 9. 

• When citing Scripture, the following needs to be included:  

1) The version of the Bible: this needs to be done only the first time, unless more than 

one version is used throughout the paper.  The version can be abbreviated and should 

be in italics.  It is placed one space after citing the book, chapter, and verse. 

2) Book, Chapter, and Verse: the name of the book can be abbreviated (see MLA 

Handbook, pp. 97-99); after one space, give the chapter followed by either a colon or 
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a period (choose one and be consistent), and the verse (e.g. Eph. 2:10, NAS; Heb. 

12.1-3, NIV). 

2. The List of Works Cited (see also “5. Placement of the List of Works Cited,” page 5) 

• The list contains only the works cited in the paper, not all works consulted. 

• If the assignment is to include all works consulted, change the heading to Works 

Consulted (or, Bibliography, depending on the Instructor’s preference). 

• Center the heading, Works Cited, one inch from the top of the page. 

• Double space between the heading and the first entry. 

• Begin each entry flush with the left margin.  If an entry runs more than one line, indent 

the subsequent line(s) one-half inch. 

• Alphabetize entries by the author’s last name.  If the author is unknown, alphabetize by 

the first word in the title (or second word, if title begins with A, An, or The). 

• When citing two or more entries by the same author, give the author’s name in the first 

entry only; thereafter, in place of the name, type three hyphens followed by a period. 

• Multiple entries by the same author should be alphabetized by the titles.   

• The “double-space the entire document” format also applies to the list of Works Cited. 

3. Documenting Sources of Information in the list of Works Cited 

• The list identifies the sources of information cited in the text of the paper. 

• Each entry in the list of Works Cited contains core elements which need to be given in a 

specific order followed by specific punctuation. 

• The three primary elements are author, title of source, and title of container(s).   
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• See the MLA Handbook, pages 20-58, for an explanation of the elements and how they 

differ from one medium to another.  (There are examples of frequently used sources in 

this summary on pages 9-11.)     

• There is a practice template in the MLA Handbook, page 129; during research, students 

might find it helpful to use one template to document each source. 

Section 4 – Examples 

1. In-Text Citations (also called Parenthetical Citations), for references within the text 

 

Example A 

 

“The content of the letter is consistent with the view that James the brother of the Lord is 

its author” (Holloway 15). 

Explanation: The author’s last name, Holloway, and the page number, 15, are 

placed in parentheses after the quotation about the authorship of James, which tells 

the reader where the information was found. 

 

Example B 

 

Holloway states that “the content of the letter is consistent with the view that James the 

brother of the Lord is its author” (15). 

Explanation: Since the author’s name is mentioned in the text, it is not necessary to 

repeat it in the parenthetical citation. 

 

Example C 

 

Although an initial reading of James makes it appear that he and Paul disagree, it must be 

understood that they are discussing “works” and “faith” differently (Holloway 71). 

or 

Holloway suggests that an initial reading of James makes it appear that he and Paul 

disagree, but it must be understood that they are discussing “works” and “faith” 

differently (71). 

Explanation: Although this is a paraphrase by the one writing the paper and not a 

direct quotation from the book, reference still needs to be given to the author(s) 

because it is his idea. 

 

Example D 

  

On the use of numbers in Revelation, “the number ‘2’ came to stand for strengthening, 

for confirmation, for redoubled courage and energy” (Summers, Worthy 21).  

or  
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On the use of numbers in Revelation, Summers wrote, “the number ‘2’ came to stand for 

strengthening, for confirmation, for redoubled courage and energy” (Worthy 21).  

or  

In Summers’ Worthy is the Lamb, he states, “the number ‘2’ came to stand for 

strengthening, for confirmation, for redoubled courage and energy” (21).  

Explanation: When there are two or more entries by the same author in the list of 

Works Cited, include the first word(s) of the title (excluding A, An, or The) to 

distinguish between sources by the same author.  If the author’s name is given in the 

text, but the source is not given, follow the second example.  If the author’s name 

and the book’s title are both given in the text, follow the third example. 

 

2. Examples of Frequently Cited Books and Periodical Articles in Print  

One Author (see MLA Handbook, page 21; hereafter, only page numbers are given) 

Hostetler, Michael. Illustrating the Sermon. Zondervan Publishing House, 1989. 

Van Ryn, August. The Epistles of John. Loizeaux Brothers, 1948. 

Two or More Authors (21-22) 

Lewis, Ralph L., and Gregg Lewis. Inductive Preaching. Crossway Books, 1983.   

Bratcher, Ed, et al. Mastering Transitions. Multnomah Press, 1991. 

Editor/Editors (23) 

Duduit, Michael, editor. Handbook of Contemporary Preaching. Broadman Press, 1992.  

Black, David Alan, and David S. Dockery, editors. New Testament Criticism and 

Interpretation. Zondervan Publishing House, 1991.    

Translation (23) 

Kee, Howard Clark, translator. Introduction to the New Testament. 17th ed., by Werner 

Georg Kümmel, Abingdon Press, 1973.   

Author’s Name not Given (24-25) 

 MLA Handbook. 8th ed., Modern Language Association of America, 2016. 

Title with a Sub-Title (25) 
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Holloway, Gary. The College Press NIV Commentary: James and Jude. College Press 

Publishing, 1996. 

Freeman, Harold. Variety in Biblical Preaching: Innovative Techniques and Fresh 

Forms. Word Books Publisher, 1987. 

  

Article/Essay in a Reference Book or a Collection or Articles/Essays (e.g. Dictionary, 

Encyclopedia, Anthology) (26-27, 30) 

Miller, Calvin. “Narrative Preaching.” Handbook of Contemporary Preaching, edited by 

Michael Duduit, Broadman Press, 1992, pp. 103-16. 

Hunter, S. F. “Eutychus.” The International Standard Bible Encyclopaedia, general 

editor, James Orr, vol. 2, Wm. B. Eerdmans Publishing, 1956, p. 1039. 

Article in a Journal, Magazine, or other Periodical (30, 39-40) 

Lewis, Tim. “The Protective Power of Repetition.” Gospel Advocate, vol. 158, no. 7, July 

2016, pp. 12-14. 

Payne, Karl. “Removing Demonic Oppression.” Leadership Journal, vol. 33, no. 2, 

Spring 2012, pp. 39+. 

Bible (38, 122-23) 

The New American Standard Bible. Reference ed., Foundation Publications, 1996.  

The New Revised Standard Version Bible. Zondervan, 1989. 

Second or Subsequent Edition (38-39) 

Trull, Joe E., and James E. Carter. Ministerial Ethics: Moral Formation for Church 

Leaders. 2nd ed., Baker Academic, 2004. 
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Ferguson, Everett. A Cappella Music in the Public Worship of the Church. Revised ed., 

Biblical Research Press, 1972.  

Multivolume Works (39-40) 

Ahlstrom, Sydney E. A Religious History of the American People. Vol. 2, Image Books, 

1975. 

Introduction, Preface, Foreword, or Afterword (written by someone other than the 

book’s author) (106)  

Green, Michael. Editor’s Preface. Between Two Worlds: The Art of Preaching in the 

Twentieth Century, by John R. W. Stott, Wm. B. Eerdmans Publishing, 1982,    

pp. 7-8. 

Kohls, L. Robert. Foreword. Cross-Cultural Reentry: A Book of Readings, edited by 

Clyde N. Austin, Abilene Christian UP, 1986, pp. xix-xxi.   

Two or more Books by the same Author/Authors (113-14) 

London, H. B., Jr. Pause, Recharge, Refresh: Devotions to Energize a Pastor’s Day-to-

Day Ministry. Tyndale House Publishers, 2009. 

London, H. B., Jr., and Neil B. Wiseman. Pastors at Greater Risk. Regal Books, 2003. 

---. Your Pastor Is an Endangered Species. Victor Books, 1996.  

Wiersbe, Warren, and David Wiersbe. The Elements of Preaching. Tyndale House 

Publishers, 1986. 

Wiersbe, Warren W. The Dynamics of Preaching. Baker Books, 1999.   

---. Be Right: An Expository Study of Romans. Victor Books, 1977. 
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3. Examples of a list of Works Cited (note: in a research paper, Works Cited should be the 

first line on the page)  

Works Cited 
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Ferguson, Everett. A Cappella Music in the Public Worship of the Church. Revised ed., Biblical 

Research Press, 1972. 

Freeman, Harold. Variety in Biblical Preaching: Innovative Techniques and Fresh Forms. Word 

Books Publisher, 1987. 

Green, Michael. Editor’s Preface. Between Two Worlds: The Art of Preaching in the Twentieth 
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Kümmel, Abingdon Press, 1973. 
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Austin, Abilene Christian UP, 1986, pp. xix-xxi.   
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Lewis, Ralph L., and Gregg Lewis. Inductive Preaching. Crossway Books, 1983. 
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Payne, Karl. “Removing Demonic Oppression.” Leadership Journal, vol. 33, no. 2, Spring 2012, 

pp. 39+. 

Rasmussen, Larry. “New Wineskins.” Interpretation, vol. 65, no. 4, Oct. 2011, pp. 364-76.  

Reese, Jack. Foreword. Freshness for the Far Journey, by Lynn Anderson, Abilene Christian 

UP, 1992, pp. 11-12. 

Trull, Joe E., and James E. Carter. Ministerial Ethics: Moral Formation for Church Leaders.  

2nd ed., Baker Academic, 2004. 

Van Ryn, August. The Epistles of John. Loizeaux Brothers, 1948. 
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1986. 
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